
Click the Help Topics button to return to the list of topics.



About Main View Preferences

Use Main View Preferences to change the zoom levels and the size at which text in the document window is greeked.    These 
choices stay in effect until you change them again.

To get information on an option in a dialog box, click , then click the option.

             To change zoom levels for the main viewer  

            Related Concepts  



To zoom out by increments you can change,

1 Click Zoom  percentage.

Tips
You can also click the Zoom button at the bottom right of the viewer, then click a percentage.
To change the zoom percentages that appear on the list, click Edit 

 Preferences 
 Main View.

            Related Topics   

            About Zooming Out  



To zoom in by increments you can change,

1 Click Zoom  Zoom In.

Tips
You can also click the Zoom button at the bottom right of the viewer, then click a percentage.
To change the zoom percentages that appear on the list, click Edit 

 Preferences 
 Main View.

            Related Topics   

            About Zooming In  



About Runtime Files

You can create two different types of Envoy* files: an Envoy document (.EVY) or a "self-opening" runtime file (.EXE).

IMPORTANT:    If you are using the Envoy Distributable Viewer and have not purchased the full Envoy product, you cannot create 
runtime files.

The Pros and Cons of Runtime Files

The advantage of a runtime file created with Envoy 7 is that anyone running Windows* 95 can open your Envoy file, even if they 
don't have an Envoy Viewer.    But if you want to send the file to someone using a Macintosh, create a regular Envoy file (.EVY) 
and make sure the recipients have the Envoy 7 Viewer for Macintosh*.

Because it is attached to the Runtime Viewer, a runtime file (.EXE) takes up more disk space than an Envoy document (.EVY).    
If file size is critical, you may want to create an .EVY file and make sure recipients have the Envoy Distributable Viewer for 
Windows 95.

Also, note that neither kind of Envoy file (.EVY or .EXE) created under Windows 95 can be opened under Windows 3.1.

             To create a runtime file  

            Related Concepts  



destination

Lets you open the document in the Envoy viewer, send the document immediately via E-mail, save the document to a folder you 
select, or save the document to the Envoy 7\Spool folder.    If you want to select different destinations and file formats without 
opening the Properties dialog box, select Prompt for destination and format type when printing.



scaling

Enlarges or reduces what prints on screen and on the printed page.



About Envoy Viewer

Envoy* is an electronic publishing program that lets you create,    annotate, and distribute files quickly and easily.    Envoy Viewer 
files can be exchanged easily between Windows* and Macintosh* platforms.

IMPORTANT:    If you are using the Envoy Distributable Viewer and have not purchased the full Envoy product, you cannot create 
Envoy files.

Use About Envoy Viewer to get information about the program release date and your license number.

             To get release date and license information  



About Font Embedding

Envoy automatically reproduces fonts using intelligent font mapping.

However, you may want to embed some fonts in the files you create.    Embedding ensures that the exact fonts will appear in the 
file you send, regardless of the fonts the recipient has installed.    But note that adding fonts also adds somewhat to file size.

Envoy* 7 uses Bitstream* TrueDoc* font embedding, which provides font fidelity with all character sets and all standard font 
formats.    Only the characters you actually use in your file are embedded, which is the most efficient way to embed fonts.

             To embed fonts  

            Related Concepts  



Open in the Envoy Viewer

Opens the Envoy Viewer with your new Envoy file displayed.



Save to disk

Saves your new Envoy file to a directory you specify.



Send by E-mail

Opens an e-mail message with your new Envoy file as an attachment.



Print to the Envoy spooling folder

Saves your new Envoy file to a directory called SPOOL that was created when you installed Envoy (for example, C:
\OFFICE7\ENVOY7\SPOOL).



About Opening a File

Use Open to open an Envoy* file from within the Envoy Viewer.    You can open several files at a time.    The actual number of 
files you can open depends on how much memory is available on your computer, the size of the files, and other factors.

The names of the files currently open show on the Window menu.    The names of the files you have most recently opened show 
on the File menu, and appear there again the next time you open Envoy.    You can reopen a file by clicking its name on the File 
menu.    You can also open an Envoy file by clicking its icon on the Windows* 95 desktop.

             To open a file  

            Related Concepts  



About Saving a File

Use Save to save the current document for the first time or to replace the current document on disk.    Use Save As to save the 
current document with a new name, in a different folder, with security restrictions, or in a new format.

If you have saved an earlier version of this file, Save will replace the document on disk with the version in the viewer.    If you 
don't want to replace the document on disk, use Save As and rename the file before you save.

             To save the current document with a new name  

            Related Concepts  



About Highlighting

Use the Highlight tool to highlight text or a rectangular area you select.    You can change highlight style and color with Highlight 
Properties.

To get information on an option in a dialog box, click , then click the option.

            To customize highlighting  

            To highlight part of a document  



About Thumbnail Preferences

Use Thumbnail Preferences to change the default zoom level, screen position, page number display, and greeking level for the 
thumbnail views.    These choices remain in effect until you change them.

To get information on an option in a dialog box, click , then click the option.

            To change the thumbnail defaults  

            Related Concepts  



About Main View Preferences

Use Main View Preferences to change the zoom levels and the size at which text in the main viewer window is greeked.    These 
choices stay in effect until you change them again.

To get information on an option in a dialog box, click , then click the option.

            To change zoom levels for the main viewer  

            Related Concepts  



About Resolution Settings

Use the Envoy* 7 Driver settings to make trade-offs between the size of .EVY files and their overall quality.

For example, if you don't have enough disk space, you can make your Envoy file smaller by choosing lower resolution settings.    
In many cases, the difference in quality is minimal.    If disk space is no object and you want the highest-quality graphics, you can 
choose higher resolution settings.

Bitmap Resolution Affects File Size

Higher resolution settings increase file size most noticeably when there are bitmap graphics in the file.    Higher settings affect file 
size much less dramatically when there are vector graphics (such as .WPG graphics) in the file.

Display Quality Is a Result of Many Variables

Display quality is limited not only by the resolution settings you choose, but also by the system on which the Envoy file is viewed. 
For example, if the recipient of your file has a computer that displays images at 120 dots per inch (dpi) or less and uses a 
maximum of 256 colors, higher resolution settings than these will not affect display quality.

Because there are so many variables (including the capabilities of the authoring application), there are no formulas for choosing 
resolution settings.    But creating an Envoy file is fast, so you can experiment without investing a great deal of time. The best 
way to determine the optimum resolution settings is to try creating a file using various settings, then view the results in Envoy.

            To create a smaller .EVY file  

            Related Concepts  



About Bookmarks

Like a physical bookmark, the Bookmark feature in Envoy* lets you mark a place in a document so you can find it again quickly. 
Or you can use bookmarks to help recipients of your Envoy document find important points.

When you create a bookmark, you give it a label that is added to an alphabetical list of bookmarks.    To jump to a marked place, 
simply click its label in the alphabetical list.

To get information on an option in a dialog box, click , then click the option.

            To create a bookmark  

            To customize bookmarks  

            To use bookmarks  



About Hypertext Links

Use Hypertext to create a link between two parts of a document or between two Envoy* documents.    Once the link is created, 
you can jump from the source to the destination area.

You can create a hypertext link in any open Envoy file, or you may receive an Envoy file that contains hypertext links.

A hypertext source can appear as highlighted text, a rectangle, or a button with an icon on it.    If you aren't sure whether 
something is a hypertext source, move the Select pointer over it.    The pointer changes to a hand over a hypertext source.

To get information on an option in a dialog box, click , then click the option.

            To change the appearance of a hypertext link  

            To create a hypertext link  

            To edit a hypertext link  

            To jump to a hypertext link  



About QuickNotes

What Is a QuickNote?

Like paper sticky notes, the QuickNote feature in Envoy* lets you make comments that get noticed and that can be moved.    You 
can also edit QuickNotes, change their appearance, import them from other Envoy files, and import and export QuickNote text 
using the Clipboard.

Making a QuickNote into an Icon

You can minimize a QuickNote by making it appear as an icon.    You can select one of several icon styles using QuickNote 
Properties.

Printing QuickNotes

Unless you hide annotations, QuickNotes will print when you print a file on paper.    For best printing results, be sure your 
QuickNotes are a light color and are no less than a quarter inch from the edge of the page.

QuickNote Author

The name of the person who created a QuickNote (its author) appears on the status line when the QuickNote is selected.    This 
is useful when more than one person has commented on a file.

To get information on an option in a dialog box, click , then click the option.

            To create a QuickNote  

            To customize QuickNotes  

            To make a QuickNote appear as an icon  

            To open a QuickNote icon  

            To place QuickNote text on the Clipboard  

            Related Concepts  



About Close, Close All, and Exit

Use Close or Close All to close an Envoy* file or files.    The Envoy Viewer remains open.

Use Exit to close the Envoy Viewer. If you have changed a file, you will be prompted to save it before you close or exit.

To get information on an option in a dialog box, click , then click the option.

            To close a file  

            Related Concepts  



About Copy

Use Copy to copy selected text and graphics to the Clipboard.

Graphics are copied to the Clipboard as .WMF files in Windows*.    Scalable graphics remain scalable.

To get information on an option in a dialog box, click , then click the option.

            To copy text or graphics to the Clipboard  

            Related Concepts  



About Moving within a Document

There are many ways to move within an Envoy* document. 

To scroll through the current document, use the scroll bars on the viewer window.

To cycle through pages or views, use the View menu (or the corresponding buttons on the viewer).

To move to a particular page number, use Go To Page.

You can search for text or for a type of annotation with Find.

You can also use the keyboard to move within a file, QuickNote, or dialog box.

To get information on an option in a dialog box, click , then click the option.

            To go to a particular page number  

            To move in a file by page or view  

            To search for text  

            To use thumbnails to move to another page  

            Related Concepts  



About Hiding Annotations

You can make annotations (QuickNotes, highlights, bookmarks, links, and embedded objects) temporarily disappear from the 
main viewer window and thumbnails.    This may be useful when printing on paper.

            To hide annotations  

            Related Concepts  



About Importing Annotations

Use Import to copy annotations from one file (the source) to another file (the destination).

When you import annotations, they are copied to the same page number in the destination file.    If the destination file is shorter 
than the source file, annotations on page numbers not present in the destination file won't be imported.    The properties of 
imported annotations remain the same.

To get information on an option in a dialog box, click , then click the option.

            To import annotations  



About Printing to Paper

Use Print to print an Envoy* file on paper.    The file prints exactly as you see it in the Envoy Viewer.    Make sure all annotations 
are at least one-quarter inch from the margins.

            To print to paper  



About Creating an Envoy File

Ways to Create an Envoy File

You can create an Envoy* file several ways.    The most common way to create an Envoy file is to print it from within another 
Windows* 95 application.    You can also create an Envoy file from the desktop, without opening another application.    From 
within Envoy you can create a file by importing a file that already exists in another format.    You can even create a new file within 
Envoy by copying pages from other Envoy files into a blank file.    This makes it easy to create an Envoy file wherever you are 
working.

The Envoy Viewer and Driver

You can view Envoy files without purchasing Envoy.    The Envoy Distributable Viewer and Runtime Viewer are available without 
cost.    However, you must purchase the Envoy 7 Driver in order to create Envoy documents.

Destinations and File Types

When you create an Envoy file, you specify the destination.    The default destination opens your new Envoy file in the Envoy 
Viewer.    When you create an Envoy file you can also choose whether you want it to be a "regular" Envoy file (.EVY) or a runtime 
file .

Results

Envoy files preserve the fonts and page layout of the original file, and files can be compressed smaller than their original size.

            To create a new file in the Envoy Viewer  

            To create a runtime file  

            To create a smaller .EVY file  

            To create an Envoy file from within an application  

            To create an Envoy file without opening an application  

            To import a file  

            Related Concepts  



About Find

Use Find to search for text, a QuickNote, a highlight, an OLE object, a hypertext source, or a bookmark within the current Envoy* 
file.    If a match is found, it appears selected in the viewer.

To get information on an option in a dialog box, click , then click the option.

            To search for annotations  

            To search for text  



About Selecting Text or Graphics for Export

Use the Selection tool to select text or graphics for export.    You can select text across multiple pages.

            Related Concepts  



About Selecting Thumbnails

Use the Selection tool to select entire pages using the thumbnail views.    Then you can move, add, delete, or copy the pages.

A selected thumbnail appears with a thick colored outline.

            To select thumbnails  

            Related Concepts  



About Sending an Envoy File by E-mail

Use Send to send an Envoy* file as an e-mail attachment.    In Envoy, Send works with any VIM- or MAPI-compatible e-mail 
application.

A runtime file (*.exe) becomes a regular Envoy file (*.evy) when sent through e-mail from within Envoy.    In order to keep the 
runtime format, open your e-mail application and send the runtime file as an attachment.

            To send the current Envoy file by e-mail  

            Related Concepts  



About Envoy 7 Driver Properties

When you install Envoy*, the Envoy Printer Driver is added to your Windows* system folder, enabling any Windows application to 
access it.

You can select default destination, paper size and orientation, print quality, and font embedding for the Envoy 7 Driver from the 
Windows 95 Start menu or from within any application.    The steps in the topic below start from the Envoy Viewer.

            To change the Envoy 7 Driver default settings  

            Related Concepts  



About the Toolbar and Status Bar

The Toolbar is the row of buttons at the top of the document in the Envoy* Viewer.    These buttons provide shortcuts to 
commonly used Envoy features.

The status bar is the space at the bottom of the viewer that contains instructions on the left and buttons on the right.    The 
instructions tell you what to do next as you perform a task.    The buttons display the page number, zoom level, and bookmarks (if 
any) of the current document.

By default, the Toolbar and status bar display whenever you open the Envoy Viewer, but you can hide them.

To get information on an option in a dialog box, click , then click the option.

            To hide the status bar  

            To hide the Toolbar  

            Related Concepts  



About Zooming In

Use Zoom In to enlarge what appears in the main viewer window.    You can zoom in three ways, explained below.

Zoom in by fixed amounts on the upper-left portion of the main viewer window.    These amounts are preset and cannot be 
changed.    For example, clicking Zoom In on the Zoom menu can change the zoom level from 310% to 390%.    Click Zoom In again 
to go to 490%.    The zoom button at the bottom right of the viewer shows the current zoom level.

Zoom in on the upper-left portion of the main viewer window by increments you can change.    Although preset increments 
show as percentages on the Zoom menu and on the Zoom pop-up menu, you can change these percentages using Main View 
Preferences.    The Zoom pop-up menu appears when you click the zoom button at the bottom right of the viewer.

Zoom in by any amount.    The Zoom In tool lets you select an area and enlarge it to fit the entire main window.    As you 
select the area, the status bar shows the exact percentage you are zooming in.    For example, if you start at 50% and the status bar 
shows 100% when you finish selecting the area, the result will be twice the size of the original.

To get information on an option in a dialog box, click , then click the option.

            To zoom in by any amount  

            To zoom in by fixed amounts  

            To zoom in by increments you can change  

            Related Concepts  



About Zooming Out

Use Zoom Out to shrink what appears in the main viewer window.    You can zoom out three ways, explained below.

Zoom out by fixed amounts.    These amounts are preset and cannot be changed.    For example, clicking Zoom Out on the 
Zoom menu can change the zoom level from 400% to 320%.    Click Zoom Out again to go to 260%.    The zoom button at the 
bottom right of the viewer shows the current zoom level.

Zoom out by increments you can change.    Although preset increments show as percentages on the Zoom menu and on 
the Zoom pop-up menu, you can change these percentages using Main View Preferences.    The Zoom pop-up menu appears when 
you click the zoom button at the bottom right of the viewer.

Zoom out by any amount.    The Zoom Out tool lets you shrink the contents of the main window to fit within a rectangle you 
create.    As you create the rectangle, the status bar shows the exact percentage you are zooming out.    For example, if you start at 
100% and the status bar shows 50% when you finish creating the rectangle, the result will be half the size of the original.

To get information on an option in a dialog box, click , then click the option.

            To zoom out by any amount  

            To zoom out by fixed amounts  

            To zoom out by increments you can change  

            Related Concepts  



About Editing a File

Because an Envoy* file is much like a printed page, you cannot edit the text of an Envoy file as you would in a word processor.

However, you can use the thumbnails to rearrange pages within an Envoy file, to add pages from another Envoy file, or to delete 
pages.

IMPORTANT: Delete pages with care; you cannot reverse the deletion.

You can also cut QuickNote text and place it on the Clipboard, or paste Clipboard text into an Envoy file in the form of a 
QuickNote.

            To add pages to an open file  

            To delete a page  

            To edit a file  

            To paste Clipboard contents into an Envoy file  

            To place QuickNote text on the Clipboard  

            To rearrange pages in an Envoy file  

            To select thumbnails  



About OLE

Linking vs. Embedding

You can insert OLE objects (such as figures, animation clips, sound clips, charts, and so on) into an Envoy* file from other 
Windows* applications.    Objects can be either linked or embedded.    Both methods place a copy of the object in your Envoy file. 
In most cases, when you double-click the object, its source application launches (if it is installed).    You can then edit the object 
in its source application without exiting Envoy.

The main difference between linking and embedding is the location where the data for the object is stored.    The data for a linked 
object remains in the source file.    The data for an embedded object is stored in the destination (Envoy) file.    So, if you are going 
to distribute an Envoy file to anyone who might not have the source application, linking will not work.    Embedding increases the 
size of the Envoy file but allows you to distribute the file more freely.

OLE Object and Container Applications

Applications that support OLE can be Objects or Containers.    Envoy 7 is an OLE 1.0 Object and Container.    You can link or 
embed objects into Envoy from OLE Container applications, and you can link or embed objects from Envoy into OLE Object 
applications.

For more information about OLE, see your Windows manual.

Printing OLE Objects

The source application for a linked or embedded object determines how the object appears on screen and when printed.

            To display OLE links  

            To edit an OLE link  

            To edit an OLE object  

            To embed an OLE object into an Envoy file  

            To link an OLE object to an Envoy file  



About the Window Menu

Use the Window menu to easily rearrange open files for easier viewing, to close all files at once, to arrange minimized open files 
in the viewer, or to activate any open file.

            To activate any open file in the Envoy Viewer  

            To arrange minimized files in the Envoy Viewer  

            To close all open files at once  

            To rearrange your windows  



About Thumbnails

Thumbnails are miniature representations of the pages in the current Envoy* file.    You can change the size and placement of 
thumbnails.    Although the text on thumbnails is greeked, you can also use thumbnails to add annotations, navigate, and add, 
delete, or rearrange pages. 

            To add pages to an open file  

            To delete a page  

            To display thumbnails  

            To rearrange pages in an Envoy file  

            To use thumbnails to move to another page  



Can be viewed with or without Envoy installed

Creates an Envoy file that is attached to an Envoy Runtime Viewer.    An Envoy Runtime Viewer can open the one file attached to 
it, even without Envoy installed, but it can open only on the same platform on    which it was created.    An Envoy Runtime Viewer 
created in Windows 95 can open on any system running Windows 95; an Envoy Runtime Viewer created on a Macintosh can 
open only on a Macintosh. 



QuickMenu

A menu that pops up in the viewer when you right-click a selected item.    Each QuickMenu has options specific to the kind of 
item selected.



OLE Object application (definition)

The application in which you link or embed an OLE object.



OLE embedding (definition)

Placing a copy of an object in your document without a link to the original.    This means you can edit the copy without altering the 
original.



OLE linking (definition)

Placing a copy of the object in your file with a dynamic link to the original in the source application.    When you edit either the 
copy or the original, the other is automatically updated.



OLE Container application (definition)

The source application in which you create the object you will embed in or link to your Envoy file.





About Converting PostScript Files

Native PostScript* files can be converted to Envoy* format using a third-party product.    Some documents that contain EPS 
images can be converted to Envoy format using the Envoy 7 Driver, but EPS image quality may vary depending on the 
application used to create the image.

            To preserve the quality of EPS images  

            Related Concepts  



About Security Settings

Because Envoy* files are so portable and easy to view, you may want to safeguard your document by adding security restrictions 
such as a password.

To get information on an option in a dialog box, click , then click the option.

            To add document security  

            Related Concepts  



intelligent font mapping

When Envoy displays a document on a system that does not have the original fonts, it automatically selects the typeface closest 
to the original and, if necessary, scales the font to preserve document spacing.



About Planning Your Envoy Document

When you create a document that you intend to publish in Envoy*, it helps to consider whether you expect others to view your 
Envoy document on screen or print it to paper.    You can maximize on-screen viewing the following ways.

Increase font size.

Reformat the layout to fit screen size and orientation.

Change Envoy Printer Driver settings to increase resolution.

Add hypertext and bookmarks to the Envoy file.

            To create a bookmark  

            To create a hypertext link  

            To create an Envoy file from within an application  

            Related Concepts  



About Envoy

Envoy* is a publishing tool that lets you exchange, distribute, view, and annotate portable electronic documents across different 
computers and operating systems.    Publishing with Envoy is faster and less expensive than publishing on paper.    Envoy 
preserves fonts and page layout, and files can be compressed smaller than their original size.

Once you have created an Envoy document, you can easily add annotations to it such as highlighting, QuickNotes, hypertext 
links, bookmarks, or OLE links.    You can send the document to others and ask them to annotate it, then you can import all the 
annotations from various recipients into one easy-to-view file.

When you publish to Envoy, you can select from four destinations and two file types.    Click these terms for a brief explanation of 
each option.

Open in the Envoy Viewer

Save to disk

Send by E-mail

Print to the Envoy spooling folder

Prompt for destination and format type when printing

Can be viewed with or without Envoy installed

Can be viewed only with Envoy installed

            To create an Envoy file from within an application  

            To create an Envoy file without opening an application  

            Related Concepts  



Tips for Using Keystrokes

Use the following CUA keystrokes within the main viewer window, within a QuickNote, or within a dialog box.

To move within the main view to 
the . . .

Press the CUA keystroke:

Beginning of a document Ctrl+Home

Bottom of the screen PgDn

End of the document Ctrl+End

Next page Alt+PgDn

Previous page Alt+PgUp

Specified page Ctrl+G

Previous document Ctrl+Shft+F6

Next document Ctrl+F6

Previous window Ctrl+Shft+F6

Next window Ctrl+F6

Within a QuickNote, to . . . Press:

Delete to the left Backspace

Delete to the right Delete

Go to line beginning Home

Go to line end End

Go to next word Ctrl+Right-arrow

Go to previous word Ctrl+Left-arrow

Move right one character Right-arrow

Move left one character Left-arrow

Move one line down Down-arrow

Move one line up Up-arrow

Other editing keystrokes: Press:

Copy text to the Clipboard Ctrl+C

Cut text to the Clipboard Ctrl+X

Paste text from Clipboard Ctrl+V

Cancel Esc

While in a dialog, to . . . Press:

Move to the next control Tab

Move back one control Shft+Tab

Perform the default action Enter

            Related Concepts  



About the Envoy Annotation Features

Use the Envoy* annotation features to comment on, highlight, bookmark, or link files.    You can use OLE to insert information 
from another application into your Envoy file.    You can also import annotations from various recipients into one comprehensive 
file.

Although the uses of these features vary with your purpose and imagination, the suggestions below may help you get started.

Bookmarks

To quickly find parts of your document, create a bookmark for each part.

Highlighting

Highlight passages you want to emphasize.

Hypertext links

Link two related parts of a document.    Create a table of contents or index that jumps to the page for each entry.

OLE

Create a newsletter with an OLE link to a spreadsheet.    When you change the figures in the spreadsheet, it automatically 
updates in your Envoy file.

QuickNotes

Make comments, ask questions, or point out something in the file.    Have several people comment on one file, each using a 
different QuickNote color.

Web links

Link two separate documents.    Link the current Envoy file to a file on the World Wide Web.

To get information on an option in a dialog box, click , then click the option.

            To create a bookmark  

            To create a hyperlink to a non-Envoy file  

            To create a hypertext link  

            To create a QuickNote  

            To highlight part of a document  

            To link an OLE object to an Envoy file  

            Related Concepts  



About the Envoy Distributable Viewer

The Envoy* Distributable Viewer lets you view files created using the full Envoy product.    The Distributable Viewer looks like the 
full Envoy viewer, but the following features are not active in the Distributable Viewer:

Import File

Save as Runtime Viewer

Send

IMPORTANT:    If you want to create or publish Envoy files, you must purchase the full Envoy product.    If you already own the 
full Envoy product, you can copy the Distributable Viewer for others to use with your files, but the driver cannot be distributed.

            To copy the Distributable Viewer  

            Related Concepts  



To place QuickNote text on the Clipboard,

1 Select the QuickNote.

2 Click Edit  Cut or Copy.

Tips

To paste Clipboard contents into an Envoy* file, click Edit 

 Paste, then click in the main viewer window or on a thumbnail.

            Related Topics   

            About Editing a File  



To create a runtime file,

1 Create a document in any Windows* application that prints.

2 Choose Print, then select the Envoy* 7 Driver in the printer list.

3 Click Properties, then select Viewable with or without Envoy Viewer (Runtime).

4 Select any other options from Paper, Resolution, and Fonts, then click OK twice.

Tips

Step 2 will vary somewhat depending on the application.    For example, in WordPerfect* 7 for Windows 95, click File 

 Print.

You can also create a runtime file in Envoy using Save As.

When you distribute a runtime file, you may want to tell recipients how to open it.    A runtime file can be opened the same 
way you open any other program file in Windows 95. Customer support for the Runtime Viewer is available for a per-minute charge 
at (900)555-5020. 

            About Runtime Files  



To get release date and license information,

1 Click Help  About Envoy* Viewer.

            About Envoy Viewer  



To open a file,

1 Click File  Open.
2 Select the folder that contains the file.
3 Click Files of type, then select the kind of file you want to open.
4 Select a file from the list.
5 Click Open as read-only if you want to protect the file from being changed, then click Open.

Tips

The names of the last files opened display on the File menu.    Click a file there to reopen it.

Although you can have several Envoy* files open at a time, you must open each file individually by following the steps 
above.    You cannot select more than one file in the Open dialog box.

To preview an Envoy file without opening it, right-click it in the Windows Explorer, click Properties, then click the 
Thumbnails tab.

            About Opening a File  



To save the current document with a new name,

1 Click File  Save As.
2 Select a location for the file.
3 Type in a new file name.
4 Select a file type from the Save as type list.
5 Click Security if you want to restrict file access.

Tips

Click File 

 Save if you want to replace the file with the same name.

            About Saving a File  



To highlight part of a document,

1 Click Tools  Highlight.
2 Click on text and drag to highlight text lines, or click outside text and drag a rectangle.

3 Click Tools  Highlight again to quit highlighting.

            About Highlighting  



To add pages to an open file,

1 Click View  Thumbnails 

 Top.
2 Open another Envoy* file.
3 Repeat step 1 on the second file.

4 Click Window  Tile Top To Bottom.
5 Select a page or a range of pages in one file.
6 To cut and paste, drag the selection and drop it on the other file's thumbnail area.

Tips

To copy pages, hold down the Control key while you drag and drop.

            About Editing a File  



To change the appearance of a hypertext link,

1 Click Tools  Hypertext.
2 Right-click the area you want to edit, then click Hypertext Properties.
3 Select any options.

Tips

The changes you make apply to the area you selected in Step 2, and they remain in effect for hypertext links you will 
create.

            About Hypertext Links  



To change the thumbnail defaults,

1 Click Edit  Preferences 

 Thumbnails.
2 Select any of the options.

Tips

To return to the previous settings, click Defaults.

            About Thumbnail Preferences  



To change zoom levels for the main viewer,

1 Click Edit  Preferences 

 Main View.
2 Select any of the options.

            Related Topics   

            About Main View Preferences  



To create a smaller .EVY file,

1 Open the Envoy* 7 Driver Properties dialog box.

2 Click the Resolution tab, then select Low or Medium from the drop-down list; or click Custom Quality, then specify lower 
General and Bitmap resolution settings.

3 Click JPEG, then    select one of the first three settings from the drop-down list.

Tips

Step 1 may vary depending on the application you are using.    For example, in WordPerfect* 7, click File 

    Print, click the Printer tab, select the Envoy 7 Driver, then click Properties.

            Related Topics   

            About Resolution Settings  



To create a bookmark,

1 Click Tools  Bookmark.
2 Drag over text to bookmark text lines, or drag a rectangle.
3 Type a brief label for the bookmark, then select any other options.
4 Repeat steps 2-3 to create another bookmark.
5 Click the Bookmark icon again to quit creating bookmarks.

Tips

The first few characters of selected text become the bookmark label unless you change it.

            Related Topics   

            About Bookmarks  



To create an Envoy file without opening an application,

1 Locate the file you want to publish to Envoy*.

2 Drag the file and drop it on top of the minimized Envoy Viewer.

            Related Topics   

            About Creating an Envoy File  



To create a hypertext link,

1 Click Tools  Hypertext.
2 Click on text and drag to select text lines as a source, or click outside text and drag to create a rectangle or a 

button as a source.
3 Go to the page you want to link, then drag to create the destination.
4 Repeat steps 2-3 for another link.
5 Click the Hypertext icon again to quit creating hypertext links.

Tips

The mouse pointer changes to an I-beam when you select text.

            Related Topics   

            About Hypertext Links  



To create a new file in the Envoy Viewer,

1 Click File  New.
2 Drag thumbnails from another file into the new file.

            About Creating an Envoy File  



To create a QuickNote,

1 Click Tools  QuickNote.
2 Click anywhere in the main viewer window to add a standard-size QuickNote, or drag a rectangle of any size.
3 Type the text you want on the QuickNote.
4 Click outside the QuickNote.

Tips

You can delete and add text as you would in most word processors.    Use the arrow keys to view text that scrolls off the 
view in a small QuickNote.

You can add a bookmark, a QuickNote, or highlighting to any page by clicking that page's thumbnail view.

You can make any QuickNote appear as an icon.    To do this, right-click the QuickNote and choose Close QuickNote.    To 
open a closed QuickNote, double-click its icon.

To move a QuickNote, select it, then drag.

To customize a QuickNote, right-click it, then choose QuickNote Properties.

            Related Topics   

            About QuickNotes  



To customize bookmarks,

1 Click Tools  Bookmark.
2 Right-click the bookmarked area, then click Bookmark Properties.
3 Select any options.

Tips

If you select text instead of drawing a rectangle when you create a bookmark, the first characters of selected text become 
the label unless you change it.

            About Bookmarks  



To customize highlighting,

1 Click Tools  Highlight.
2 Right-click a highlighted area, then click Highlight Properties.
3 Select any options.

Tips

Highlight properties stay in effect until you change them again.

            About Highlighting  



To customize QuickNotes,

. 1 Right-click a QuickNote, then click QuickNote Properties.

2 Select any options.

Tips

To read or edit a QuickNote icon, double-click the icon.

To resize a QuickNote, select it and drag a side or corner handle.

QuickNote properties stay in effect until you change them again.

            About QuickNotes  



To close a file,

1 Click File  Close.

Tips

To close all open files, click Window 

 Close All.

            About Close, Close All, and Exit  



To delete a page,

1 Click Tools  Select.
2 Select the thumbnail(s) you want to delete, then press the Delete key.

Tips

Delete pages carefully.    You cannot undo a deletion.

            Related Topics   

            About Editing a File  



To display OLE links,

1 Click Edit  Links.

            About OLE  



To display thumbnails,

1 Click View  Thumbnails 

 Top or Left.

Tips

You can also click the Thumbnail icon on the Toolbar to cycle through top placement, left placement, and closed.

            Related Topics   



To edit a hypertext link,

1 Click Tools  Hypertext.
2 Right-click the source or destination you want to edit.
3 Select any of the editing options.

4 Click Tools  Hypertext again to quit editing.

            About Hypertext Links  



To edit an OLE link,

1 Click Edit  Links.
2 Select the link you want to edit in the Links list box.
3 Select the editing options you want.

            About OLE  



To edit an OLE object,

1 Double-click the object to open its source application.

2 Edit the object in the source application.

3 Click File  Exit & Return to Envoy* to return to your Envoy document, or click File 

 Update to remain in the source application.

Tips

Step 3 may vary depending on the source application you are using.    For example, in an application that opens a window 
so you can create the OLE object in Envoy, close the object window by clicking outside it.

            About OLE  



To embed an OLE object into an Envoy file,

1 Click Edit  Insert Object.
2 Select the object type you want, then click OK.
3 Click in the Envoy* file where you want the object inserted.
4 Create or retrieve the object in the server application.

5 Click File  Exit & Return to Envoy Viewer, or click File 

 Update to remain in the server application.

Tips

Step 5 may vary depending on the server application you are using.    For example, in an application that opens a window 
so you can create the OLE object in Envoy, close the object window by clicking outside it.

            About OLE  



To copy text or graphics to the Clipboard,

1 Click Tools  Select.
2 Click on text and drag to select text lines, or drag a rectangle around a graphic.

3 Click Edit  Copy.

Tips

To export all the text in a file as ASCII text, click File 

 Save As, then select Text Files from the Format list.

You can also copy pages of text to the Clipboard by selecting thumbnails.

            About Copy  



To move in a file by page or view,

1 Click View.

2 Click any of the last six options.

Tips

You can also click the corresponding icons on the Toolbar.

            About Moving within a Document  



To hide annotations,

1 Click View  Annotations.

Tips

To see annotations, click View 

 Annotations again.    When annotations are visible, the Annotations menu item appears with a check mark to its left.

            About Hiding Annotations  



To import a file,

1 Click File  Import 

 File.
2 Specify the folder and name of the file you want to import to Envoy*.

Tips

If you are importing a WordPerfect* file, the filename must end in .WPD.

Importing creates an Envoy file from a file that already exists in another format.    If you want to create an Envoy file "from 
scratch" within Envoy, click File 

 New.

            About Creating an Envoy File  



To import annotations,

1 Click File  Import 

 Annotations.
2 Select the file from which you want to import annotations, then click Open.
3 Select the type(s) of annotation you want to import.

Tips

You can import annotations from only one file at a time. 

            About Importing Annotations  



To link an OLE object to an Envoy file,

1 Open the server application.

2 Create or retrieve an object in the server application.

3 Save the object with a filename.

4 If it is not already selected, select the object.

5 Click Edit  Copy to copy the object to the Clipboard.
6 Switch to Envoy.*
7 Click Edit, then click Paste.
8 Click in the Envoy file where you want to paste the object.

Tips

In step 2, if you are creating a link from a word processor, select the text you want to link.

Steps 1-5 will vary depending on the application you are using.

If an OLE link destination file becomes separated from its source file, the link is broken.    For example, if you create a link 
in Envoy, then send the Envoy file to someone who does not have access to the source file, the link does not exist.

            About OLE  



To print to paper,

1 Click File  Print.
2 Select the printer name, print range, and number of copies.
3 Click Properties if you want to select paper, graphics, fonts, or device options. 
4 Click OK to start printing.

Tips

If you want to print a file but not its annotations, hide the annotations first.

To print selected pages, first select the thumbnail view of each page you want to print, then click Selection in the Print 
dialog box.

            Related Topics   

            About Printing to Paper  



To create an Envoy file from within an application,

1 Click Start on the Windows* 95 taskbar  Settings 

 Printers.
2 Select the Envoy* 7 Driver, then click Properties on the File menu.
3 Click the Destination tab, then select a destination and format type.
4 Select Security if you want to be prompted to select access restrictions for your file (such as View Only).
5 Select any other options from Paper, Resolution, and Fonts, then click OK.

6 Open any Windows application that prints and create the file you want to print to Envoy.

7 Print the document to the Envoy 7 Driver as you would print any other document in that application.

Tips

Step 7 will vary depending on the application you are using.    For example, in WordPerfect* 7 for Windows 95, click File 

 Publish to Envoy instead of step 7.

To make each page of your document fit exactly into one Envoy Viewer screen, select Statement paper size and 
landscape orientation in your originating application before you create the file.    For example, in WordPerfect 7, click Format 

 Page 

 Page Size.    In some applications you may also need to change the page size and orientation in the Envoy 7 Driver Properties 
dialog box.

The Envoy 7 Driver Properties are defaults.    If you want to select different destinations or file formats without changing 
the defaults, select Prompt for destination and format type when printing in step 3.

            About Creating an Envoy File  



To rearrange pages in an Envoy file,

1 Click View  Thumbnails 

 Top or Left.
2 Select the thumbnail of the page(s) you want to move.
3 Drag the selection and drop it in a new position.

Tips

Thumbnails position themselves directly before the thumbnail they are dropped on.

            Related Topics   

            About Editing a File  



To search for annotations,

1 Click Edit  Find.
2 Select the kind of annotation you want.
3 Click Find Next or Find Previous to search forward or backward.

Tips

If an annotation of the type you are searching for is selected in the file, the search begins there.    If not, the search begins 
at the insertion point.

            Related Topics   

            About Find  



To search for text,

1 Click Edit  Find.
2 Type the word or phrase you want in the Find Text box.
3 Select Match Case to search for capital letters exactly as you typed them.
4 Make sure Text is selected under Find What.
5 Select Find Next or Find Previous to search forward or backward from the insertion point.

Tips

Type a word or phrase exactly as you expect to find it.    You can type partial words only at the beginning or end of the 
search phrase.    Do not use wildcards.

            Related Topics   

            About Find  



To select thumbnails,

1 Click Tools  Select.
2 Select thumbnails according to the tips below.

Tips

To select one page, click the select tool on the thumbnail.

To select multiple (but not continuous) pages, Control+click separate thumbnails.

To select continuous pages, Shift+click the first and last thumbnail you want to select.

To select all pages, Alt+click any thumbnail.

To deselect thumbnails, click outside the thumbnail area.

            About Selecting Thumbnails  



To send the current Envoy file by e-mail,

1 Click File  Send.
2 Enter a password if required.
3 Address the recipient(s) in the To box.
4 Type a subject line, if you want.
5 Type a message if you want, then click Send (or OK on some e-mail systems).

Tips

The Envoy* file is sent by e-mail and you return to the Envoy Viewer.

            About Sending an Envoy File by E-mail  



To change the Envoy 7 Driver default settings,

1 Click Start on the Windows 95 taskbar  Settings 

 Printers.
2 Select the Envoy* 7 Driver, then click Properties.
3 Click the Destination tab, then select a destination and format type.
4 Select Security if you want to be prompted to select access restrictions for your file (such as View Only).
5 Select any other options from Paper, Resolution, and Fonts, then click OK twice.

Tips

You can also change Envoy 7 Driver properties from within most applications, but you should do this before you create the 
file you are going to print to Envoy.

To make each page of your file fit exactly into one Envoy Viewer screen, click the Paper tab, then select Statement paper 
size and landscape orientation when you create the file.

If you want to select different destinations or file formats without changing the defaults, select Prompt for destination and 
format type when printing in step 3.

            Related Topics   

            About Envoy 7 Driver Properties  



To hide the Toolbar,

1 Click View  Toolbar.

Tips

To see the Toolbar, click View 

 Toolbar again.    When View Toolbar is selected, the Toolbar menu item appears with a check mark to its left.

            About the Toolbar and Status Bar  



To jump to a hypertext link,

1 Click Tools  Select.
2 Click the hypertext source area or button.

Tips

To return to the source area, click View 

 Previous View.

            Related Topics   



To use bookmarks,

1 Click Edit  Go To Bookmark.
2 Click Sort by page number if you want the list of bookmarks to display in order of page number.
3 Click a bookmark label on the list.

Tips

You can also click the Bookmarks button on the status bar.

The Bookmarks button shows only if you have already created a bookmark.

            Related Topics   

            About Bookmarks  



To zoom in by fixed amounts,

1 Click Zoom  Zoom In.

Tips

These zoom amounts are preset and cannot be changed.    If you want to zoom in by amounts you choose, use the 
percentages on the Zoom menu or use the Zoom In tool.

You can also click 

 on the Toolbar, then click in the main viewer window.

            About Zooming In  



To zoom out by fixed amounts,

1 Click Zoom  Zoom Out.

Tips

These zoom amounts are preset and cannot be changed.    If you want to zoom out by amounts you can control, use the 
percentages on the Zoom menu or use the Zoom Out tool.

You can also click 

 on the Toolbar, then click in the main viewer window.

            Related Topics   

            About Zooming Out  



To edit a file,

1 Click Tools  Select.
2 Select the thumbnail view(s) of the page(s) you want to affect.
3 Add, delete, or rearrange pages; or cut and paste QuickNote text from one page to another.

            Related Topics   

            About Editing a File  



To rearrange your windows,

1 Click Window.

2 Click any option except Close All.

            About the Window Menu  



            About the Window Menu  



To use thumbnails to move to another page,

1 Click View  Thumbnails 

 Top or Left.

2 Click View  Thumbnails 

 Show Page Numbers.
3 Double-click the thumbnail view of the page you want to view.

            About Thumbnails  



To preserve the quality of EPS images,

1 Create a PostScript* file using a PostScript driver.

2 Use a third-party program to convert the file to Envoy format.

3 Use the resolution settings in Envoy* 7 Driver Properties to control document size and image quality.

            About Converting PostScript Files  



To add document security,

1 Click File  Save As.
2 Click Security, then select any options.

            About Security Settings  



To copy the Distributable Viewer,

1 Click Start  Programs 

 Windows* Explorer.
2 Double-click Dvsetup.exe in your Envoy* folder (for example, C:\Corel\Office7\Envoy 7\Dvsetup.exe).
3 Follow the prompts to copy the Distributable Viewer files.

Tips

The Output Path is the location where you want to copy the Distributable Viewer.    You can copy the Distributable Viewer 
files to any location where there is enough space.    There is not enough space on a floppy disk to copy all the Distributable Viewer 
files.

            About the Envoy Distributable Viewer  



To display page numbers with thumbnails,

1 Click View  Thumbnails 

 Show Page Numbers.

            Related Topics   



To zoom in or out on thumbnails,

1 Right-click the thumbnail area.

2 Click a percentage on the list.

Tips

To change the percentages that appear on the list, click Edit 

 Preference 

 Thumbnails.

            Related Topics   

            About Thumbnails  



To edit a QuickNote,

1 Click Tools  QuickNote.
2 Double-click the QuickNote, then edit it.

Tips

To insert text from the Clipboard, double-click the QuickNote, place the insertion point where you want the text to appear 
in the QuickNote, then click Edit 

 Paste.

            About QuickNotes  



To embed fonts,

1 Click File  Print 

 Properties 

 Fonts.
2 Select the font(s) from the list, then click the right arrow, or click All Fonts to select all embeddable fonts.
3 Select fonts in the document as you usually would in the authoring application.
4 Print to the Envoy* Printer Driver.

Tips

All the embeddable fonts on your system are listed under Available fonts on system.

To deselect certain fonts, select them from Fonts available for embedding, then click the left arrow.

            About Font Embedding  



To create a hyperlink to a non-Envoy file,

1 Click Tools  Web Links.
2 Drag over text to select a text source, or drag a rectangle to select a non-text source.
3 Specify a local file or Internet address in the Destination text box.
4 Specify the name of a bookmark in the destination document, if you want the document to open to that 

bookmark when the source is clicked.

Tips

Different properties options appear depending on whether you selected a text or non-text source in step 2.

In step 3, you can click the file icon or the Browse Web button and select a destination.

In step 4, you must specify a bookmark that already exists in the destination document.    You can't create a bookmark 
while you are creating the hyperlink.

            Related Topics   

            About Web Links  



To hide the status bar,

1 Click View  Status Bar.

Tips

To see the status bar, click View 

 Status Bar again.    When View Status Bar is selected, the Status Bar menu item appears with a check mark to its left.

            Related Topics   

            About the Toolbar and Status Bar  



Can be viewed only with Envoy installed

Creates a "regular" Envoy file that can be opened on any Windows 95 or Macintosh system that has Envoy installed.



To paste Clipboard contents into an Envoy file,

1 Click Edit  Paste.
2 Click in the main viewer window or on a thumbnail where you want to insert the information.

Tips

Any text you paste from the Clipboard appears as a QuickNote in the Envoy* file.    A pasted graphic appears as a graphic.

You can also paste text from the body of an Envoy file into a QuickNote.    To do this, select the text, click Copy, then 
follow the steps above.

            Related Topics   

            About Editing a File  



About Web Links

Use Web Links to create a link from the current Envoy* file to any other file, even to a file on the Internet.    If you want to link to a 
specific place in the destination file, create a bookmark in the destination file and record the bookmark label before you select the 
Web Links source.

You can select text lines or a rectangle as the Web Links source.    You can change several aspects of source appeance, or 
properties.    A text source has different properties options than a non-text source.

If you install Quick View Plus*, you can specify any file location (local or Internet) in the Web Links dialog box and view other file 
formats from Envoy using the Netscape* viewer.

To get information on an option in a dialog box, click , then click the option.

            To create a hyperlink to a non-Envoy file  

            To view other file formats from Envoy  

            Related Concepts  



greeked text

Greeked text shows in the viewer or in the thumbnail views as gray lines.    Greeked text displays faster than regular text.



runtime file

A file that is attached to a Runtime Viewer, so that the file can be opened on any system running Windows 95, even if Envoy is 
not installed.    The Runtime Viewer can open only the one file attached to it, and it does not have all the features of the full Envoy 
Viewer.



To zoom out by any amount,

1 Click Tools  Zoom Out.
2 Drag a rectangle into which the contents of the main viewer window will shrink.

Tips

The zoom button at the bottom right of the viewer shows the current zoom level.

As you drag the rectangle, the status bar shows the exact percentage you are zooming out.    For example, if you start at a 
zoom level of 100% and the status bar shows 50% when you finish dragging the rectangle, the result will be one-half the size of the 
original.

            Related Topics   

            About Zooming Out  



To zoom in by any amount,

1 Click Tools  Zoom In.
2 Drag a rectangle in the main viewer window to select an area that will expand to fill the entire window.

Tips

The zoom button at the bottom right of the viewer shows the current zoom level.

As you drag the rectangle, the status bar shows the exact percentage you are zooming in.    For example, if you start at a 
zoom level of 50% and the status bar shows 100% when you finish dragging the rectangle, the result will be twice the size of the 
original.

            Related Topics   

            About Zooming In  



To arrange minimized files in the Envoy Viewer,

1 Click Window  Arrange Icons.

Tips

To minimize the active Envoy* file, click the minimize button at the top right corner of the Envoy Viewer window.

            About the Window Menu  



To activate any open file in the Envoy Viewer,

1 Click Window  title of the file you want to use.

Tips

You can also click one of the first three options on the Window menu, then click in the file you want to use.

            About the Window Menu  



To close all open files at once,

1 Click Window  Close All.

Tips

If you have changed an open file, you will prompted to save it.

To close only the active file, click File 

 Close.

            About the Window Menu  



To make a QuickNote appear as an icon,

1 Right-click the QuickNote.

2 Click Close QuickNote.

Tips

To select another icon style, right-click a QuickNote, then click QuickNote Properties.

            About QuickNotes  



To open a QuickNote icon,

1 Double-click the icon that represents a QuickNote.

Tips

To close it again, right-click the QuickNote, then click Close QuickNote.

            Related Topics   

            About QuickNotes  



About Clear

Use Clear to remove a bookmark, a highlight, a QuickNote, an OLE object, a hypertext link, or a Web Link from a document.

To get information on an option in a dialog box, click , then click the option.

            To clear a bookmark  

            To clear a hypertext link  

            To clear a QuickNote  

            To clear highlighting  



To clear a hypertext link,

1 Select the source of the link you want to delete.

2 Click Edit  Clear.

Tips

You can also right-click the hypertext source, then click Clear.

            About Clear  



To clear a QuickNote,

1 Select the QuickNote you want to delete.

2 Click Edit  Clear.

Tips

You can also right-click the QuickNote, then click Clear.

            About Clear  



To clear highlighting,

1 Select the highlighting you want to delete.

2 Click Edit  Clear.

Tips

You can also right-click the highlighting, then click Clear.

            About Clear  



To clear a bookmark,

1 Select the bookmark you want to delete.

2 Click Edit  Clear.

Tips

You can also right-click the bookmark, then click Clear.

            About Clear  



To go to a particular page number,

1 Click Edit  Go to Page.
2 Type the page number you want.

            About Moving within a Document  



About Application Preferences

Use Application Preferences to set the size or position of the entire Envoy* window next time you open Envoy.

If you want to set the size or zoom level of just the document window, use Main View Preferences.

To get information on an option in a dialog box, click , then click the option.

 To set the size or position of Envoy next time it opens  



To set the size or position of Envoy next time it opens,

1 Click Edit  Preferences 

 Application.
2 Select an option.

Tips

To set the size or zoom level of just the document window, use Main View Preferences.

            About Application Preferences  



About Document Properties

You can create a summary of a document that identifies such information as the person who created it and a description of the 
content.    A document summary is saved with the document but does not display or print with the document.    Summary 
information is visible in the Document Properties dialog box.

To get information on an option in a dialog box, click , then click the option.

            To create a document summary  



To create a document summary,

1 Click File  Properties.
2 Type or edit information in any of the text boxes.

            About Document Properties  



Prompt for destination and format type when printing

Lets you select a destination and format type for each file you create.    This is useful when you are printing several files, but you 
don't want them all to have the same destination and format type.



To customize Web Links,

1 Click Tools  Web Links.
2 Right-click a web link, then click Properties.
3 Select any options.

Tips

The changes you make apply to the web link you selected in step 2, and they remain in effect for web links you will create.

            Related Topics   

            About Web Links  



Tips for Using Resolution Settings

The Resolution Custom Settings

The following paragraphs summarize the Resolution Custom Settings options.

General Resolution

General resolution means the resolution for the entire file, excluding bitmaps. The options are given in dots per inch. You can 
select a standard setting from the list, or click Custom and type other settings in the boxes at the right.

Bitmap Resolution

Select from the list, or click Custom and type other settings in the boxes at the right (in dots per inch).

Bitmap Colors

JPEG: Smaller files, but slight loss of detail.    The options refer to resolution (Very Low resolution to Very High resolution.)    
Non-Lossy: no loss of detail, but larger files than JPEG.

Examples of How to Use the Custom Settings

The following list gives two examples of how you might want to use the settings descibed above.

If the file has many different shades and highlights, use higher dpi settings.    The resulting file will be larger.

If the file has very few shades and many solids, use lower dpi settings.    The resulting file will be smaller.

            To create a smaller .EVY file  

            Related Concepts  



About Paste Special

Use Paste Special to select a specific format when you paste information from the Clipboard into Envoy*.

To get information on an option in the Paste Special dialog box, click the option, then press Shift-F1.

            To select the format for pasted information  

            Related Concepts  



To select the format for pasted information,

1 Open the application and file you want to copy from.

2 Select the information you want to copy to the Envoy* document, then copy it to the Clipboard.

3 Switch to Envoy.

4 Click Edit  Paste Special.
5 Click Paste, then select a format from the list box.

Tips

When you click an option in the Paste Special dialog box, the Result box at the bottom tells you what the option does.

            Related Topics   

            About Paste Special  



Why does my Envoy file look different from my WordPerfect file?

A number of factors affect the way your Envoy* file turns out.    Some of the most common causes of problems are explained 
below in the first bulleted list.    The second bulleted list below gives suggestions. Most of these situations and suggestions apply 
to other applications as well as to WordPerfect.*

What Happened

The Envoy 7 Driver was not selected when you created the file.    Every font has its own unique characteristics, which 
affect word spacing, word wrap zone, line spacing, and so on.    Even fonts with the same name may be slightly different for each 
printer driver you select.    If you select a different driver after you create the file, these font differences can add up enough to cause 
the document to be reformatted.

 Some font information was not available. Fonts can reside either in your Windows fonts folder or at your printer.    When 
fonts are stored on the printer, not all of the information for the font is available to the Envoy 7 Driver.    In such cases Envoy 
will reproduce the font as closely as it can, given the information available.    Also, if the computer system where you are 
viewing the Envoy file does not have the same fonts installed as the system where you created the file, some unembedded 
fonts may look a little different.

The viewing system has limited capabilities.    Some computer systems do not have the ability to display details you 
could see on the printed page.    For example, some printers can support up to 1200 X 1200 dpi output, but the screen cannot.

Your application's color palette may differ slightly from the Envoy palette. Because Envoy was designed for cross-
platform use, the Envoy color palette is the best match for both Macintosh and Windows systems.    This means that Envoy uses a 
color palette that may not match up exactly with the color palette you are using in WordPerfect.

The zoom level may be too small.    Often you get better resolution on screen if you increase the zoom level in the 
Envoy Viewer.

What You Can Do

Before You Create the File in WordPerfect

Before you create a file in WordPerfect that you know you are going to print to Envoy, select the Envoy 7 Driver properties you 
want. This will format the file correctly for Envoy.

1 Click Start on the Windows 95 taskbar, then click Settings  Printers.

2 Select the Envoy 7 Driver, then click File  Properties.
3 Click the Destination, Resolution, or Fonts tab, then select any options.
4 Open WordPerfect 7 for Windows 95.

5 Click File  Print 

 Printer, then select the Envoy 7 Driver.
6 Create the file in WordPerfect, then print it to Envoy.

If You Are Using an Existing File

If you have printed a file to Envoy that doesn't look the way you expected it to, try the following suggestions.

Select the Envoy 7 Driver first. First, open your file again in the original application (such as WordPerfect).    Then select 
the Envoy 7 Driver before you make any more changes to the file. This will make it format correctly for the Envoy 7 Driver.

Embed fonts. Try embedding any fonts that don't appear correct in your Envoy file.

Try Make It Fit. If a document paginates differently in WordPerfect when you select the Envoy 7 Driver, try the Make It Fit 
feature, then print to Envoy again.

Enlarge graphics, or increase resolution.    If you have graphics in your file, you may want to enlarge them in the 
original application to make the details look clearer in the Envoy file.    You can also select higher resolution options for bitmaps in 
the Envoy 7 Driver Properties dialog box.

            To change the Envoy 7 Driver default settings  

            To create an Envoy file from within an application  

            To embed fonts  

            To preserve the quality of EPS images  

            To zoom in by any amount  

            Related Concepts  



About Help Online

Through Help Online you can go directly to the Envoy* 7 home page on the World Wide Web.

If you have installed Netscape Navigator* and have a modem or network connection to an Internet service provider, you can go 
to the Envoy 7 home page, which contains links to:

Information on Corel and Corel products

Download the Envoy Viewer

Envoy Hints & Tips not included in the documentation

            To access the Envoy home page  



To access the Envoy home page,

1 Click Help  Help Online.

            About Help Online  



To view other file formats from Envoy,

1 While installing Quick View Plus*, select the option that allows integration with all programs.

2 In Envoy* 7, click Tools  Web Links.
3 Specify a local path to a file that exists in any format supported by Quick View Plus (for example, type C:

\Myfiles\Anyfile.wpd).

            Related Topics   

            About Web Links  



Type the name that you want to show on the status bar when the QuickNote is selected.



Click Set, then select a background color for QuickNotes.



Click the button, then blend your own color for QuickNote backgrounds.



Aligns QuickNote text along the left margin of the QuickNote.



Click to select a font, font style, and point size for QuickNote text.



Click the arrows to select a style for closed QuickNotes.



Click Set to select a color for the text on QuickNotes.



Click to select options that limit access to your Envoy file.



Keeps the file from being changed.



Type text exactly as you expect to find it.    Do not add extra spaces or wildcard characters (such as an asterisk).



Select this to find the exact text you type in the Find box (including capital letters).



Click Text, then type the text you want to search for in the space below.    Or select the annotation type you want to search for.



Searches forward in the current Envoy file.    If text or an annotation of the type you are searching for is already selected in the 
file, the search begins there.    If not, the search begins at the insertion point.



Searches backward in the current Envoy file.    If text or an annotation of the type you are searching for is already selected in the 
file, the search begins there.    If not, the search begins at the insertion point.



Type the number of the page you want to find.



When you open a new document, it displays to fit the window width.



When you open a new document, it displays so that one page fits within the window height.



When you open a new document, it displays so that one page fits within the window height and width.



When you open a new document, it zooms to the level you specify here.



When you open a new document, the main document window is maximized.



Select a point size so that any text smaller than that point size will appear as gray lines.



Select the zoom levels you want to appear on the pop-up menu on the status bar.



Select the zoom levels you want to appear on the pop-up menu when you right-click on the thumbnail area.



Select how you want thumbnails to display when you open a new document.    Thumbnails can be hidden or can display at the 
top or left of the main viewer window.



Select a point size so that any text smaller than that point size will display as gray lines.



Opens the thumbnails to the zoom level specified here.



Select this to make thumbnails always display with page numbers.



Surrounds selected text with color.



Draws a colored line through selected text.



Click Set to select a highlight color.    This choice remains in effect until you change it.



Type the name you want to show on the status bar when a highlighted area is selected.



Surrounds the hypertext source area with a rectangle that does not appear on screen or print on paper.    This is useful if you 
want to make an existing graphic into a source, for example.



Surrounds the source area with a rectangle that is visible on screen and that prints on paper.



Click Set to select a color for the hypertext source rectangle.



Click Button, then click the arrows below to select an icon that will appear wherever you create a hypertext source.



When you jump to the hypertext destination, it will appear centered in the window.



When you jump to the hypertext destination, it zooms to fill the entire window.



Type the label you want for the selected bookmark.    If you have selected text, the first few selected characters will be the 
bookmark label unless you change it.



When you jump to the bookmark, it displays centered in the viewer window.



When you jump to the bookmark, it zooms to fill the entire viewer window.



When you jump to the bookmark, it appears selected in the window.



Click to select a file on the Internet that you want to link to the file currently open in the Envoy Viewer.



Click here to select a destination file from local folders.



Type the location of a file to which you want to link the current Envoy file, or click the file button at the right to select the file.



If you have already created a bookmark in the destination file, you can type its label here.    When the Web Links source is 
clicked, the destination file opens to the bookmark specified here.



Check Password if you want to restrict document access with a password you assign.



Type the password you want to assign to the file you are saving.



Click Unrestricted if you want others to be able to view, print, or change your file. 



Click View and print only if you want others only to read your file and print it, but not change it.



Use a detailed name for the document that is longer than or different from the document's filename.



Shows the author of the document.    If no author appears, you can type one.



Provides general information about the content of the document.    Type or edit information in the text box.



Shows important terms to help identify the topics in the document.    These keywords may be used in indexing and searching for 
the document.    Type or edit terms in the text box.



Click to close the dialog box without implementing your changes.



Click to view online Help that explains this dialog box.



Click to implement your changes and close this dialog box.



Click to return to the original settings.



Click Maximized to make the Envoy Viewer window fill your computer screen whenever you open Envoy.



Click Restored if you want the Envoy Viewer to open exactly the same size and position it was when you exited Envoy.



Click Use default to make the Envoy Viewer fill about three-quarters of the screen whenever you open Envoy. 



This square shows the color currently selected for text in a QuickNote.



This square shows the color currently selected for the background on QuickNotes.



Centers QuickNote text between the margins of the QuickNote.



Aligns QuickNote text along the right margin of the QuickNote.



Aligns QuickNote text along both the right and left margins of the QuickNote.



Surrounds the Web Links source area with a rectangle that does not appear on screen or print on paper.    This is useful if you 
want to make an existing graphic into a source, for example.



Surrounds the source area with a rectangle that is visible on screen and that prints on paper. 



This rectangle shows the color currently selected for framed rectangles.



Click Set, then select the color you want for framed rectangles.



Click Button, then click the arrows below to select an icon that will    appear whenever you create a Web Links source.



The image that shows in this box is the icon style currently selected for Web Link source buttons.



Click to select an icon style for button sources.



Type the location of the file you want to link to, or click the file button at the right to select any file not located on the Internet.



Click to select a file on the Internet that you want to link to the file currently open in the Envoy Viewer.



Click to search for QuickNotes in the current document.



Click to search for highlighting in the current document.



Click to search for embedded OLE objects in the current document.



Click to search for hypertext sources in the current document.



Click to search for bookmarks in the current document.



This list shows the bookmarks that exist in the current file, sorted alphabetically or by page number.    Select the bookmark you 
want to jump to.



Click to rearrange the list of bookmarks from alphabetical to the order in which they appear in the file.



If found, the name of the application where the original document was    created appears here.



The producer of the file is Envoy.



The date and time the file was created (printed to Envoy).



The date and time the file was last saved.



Type any page number within the range displayed here.



Click to deselect any type of annotation you do not want to import.



Type a zoom level, as a percentage.






